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FileXpress Gateway... 

...the secure file transfer solution 

FileXpress Gateway is an intuitive file transfer solution from the security experts at Attachmate. 
Use it to configure secure file exchange with business partners and employees working outside 
your corporate network. Features include: 

 Gateway Administrator console 

This web-based tool enables administrators to modify system settings, provision users, and 
configure transfers. 

 FileXpress Transfer Client 

This web-based client provides an easy drag-and-drop interface for transferring files or 
entire directories. 

 Customizable user interface 

Customize the FileXpress Transfer Client to use branding and images that identify your 
organization. 

 End-to-end encryption 

All transfers are securely encrypted. When you set up file storage on a back-end server, 
encrypted data streams continuously through the FileXpress Gateway Proxy, eliminating the 
need to save files on this server. This is more secure and more efficient than file transfer 
solutions that require the file to be stored and then forwarded. 

 Configurable transfer site access 

Transfer site managers can provide access rights to users or groups and control how long 
sites remain active. Permissions settings are available to specify who can upload and/or 
download files and who receives email notifications. 

 Self-registration by email  

New external users can be notified via email with links provided for password creation. 

 Customizable email notifications  

Customizable email templates are available for account creation, password reset, transfer 
site access notifications, and file upload and download notifications.  

 Delegation of management tasks 

Administrators can assign roles to groups and/or users, allowing these users to receive 
email notifications and manage sites, actions, and FileXpress users. 

 Post Transfer Actions 

Use Post Transfer Actions (PTAs) to trigger automated processes after files are uploaded to 
your server. 

 File Transfer auditing 

Use audit logging to maintain a complete record of all file transfer activity. 

 Server clustering 
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To maintain high availability, you can configure a Gateway Administrator cluster. Data in 
the FileXpress database is automatically replicated across all servers in the cluster.  

 Certificate authentication 

FileXpress Gateway supports user authentication with X.509 certificates. Certificate 
validation is managed by the Reflection PKI Services Manager, which is available at no 
extra charge. When certificate authentication is configured, users can authenticate using a 
smart card, or by using digital certificates stored in the operating system or browser 
certificate store. 

 Reflection for Secure IT server 

FileXpress Gateway uses Secure Shell technology to move data securely to your file storage 
server. The Reflection for Secure IT server for Windows is included in the package. You can 
configure FileXpress to transfer files to a Reflection for Secure IT server or any other SFTP-
enabled SSH server. 

 Security updates 

Our security specialists watch for potential security vulnerabilities that might affect our 
products. In the event that we learn of a new vulnerability, we keep you informed and 
resolve the issue as soon as possible. Security fixes are our top priority. 

 Responsive technical support and comprehensive documentation 

Our documentation and support team works closely with the development team and are 
committed to providing you with complete, technically accurate information about all 
facets of our products. 

 

Introduction 

A typical FileXpress Gateway distributed configuration is shown below. This configuration 
supports secure file exchange with users outside your network. Files are transferred through a 
proxy in the DMZ to a file storage server behind the firewall. In this configuration, the 
FileXpress Gateway Administrator (which manages user and transfer configuration) also runs 
securely in the internal network.  
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Note: It is also possible to install all of the FileXpress Gateway services on a single system. This 
can be useful for initial evaluation, and this simpler configuration is used in this evaluation 
guide. 

 

A Typical Evaluation Scenario 

Pat is in charge of setting up FileXpress Gateway for a medical supply company that needs to 
exchange documents containing sensitive information with customers. Traveling company 
agents also need to access documents on servers within the corporate network. Because secure 
encryption and authentication are built into every FileXpress transfer, it is the ideal solution for 
ensuring the security of customer information. The company requirements include the 
following: 

 Each sales agent needs to be able to add new customers to the FileXpress system. 

 New customers should be notified by email that they have been given access to the system.  

 New customers (external users) must be able to set up their own passwords. 

 Customers should receive email with links to transfer sites where they can download and 
upload files.  

 After customer files are uploaded to the transfer site, these files need to be copied 
automatically to the correct internal servers for follow-up processing. 

 Each agent must receive a notification each time a customer uploads or downloads files. 

 Administrators need to delegate limited administrative rights that will allow traveling 
agents to add users and set up transfer sites. 

 Sales agents and administrators (internal users) should be able to access the FileXpress 
system from any location using their corporate credentials. 

 A complete audit log must be available with of record of all transfer activity. 

Pat's evaluation would include the following procedures from this evaluation guide: 

1 Install the evaluation software (page 7). 

The procedure provided in this guide uses a simplified configuration with all services and 
transfer sites on a single server. Using this approach helps expedite preliminary testing. 

2 Perform initial system setup (page 8). 

These one-time procedures include enabling FileXpress connections in the Secure Shell 
proxy, configuring a connection to the email server, and confirming that Java is installed on 
client systems. 

3 Set up an initial test user, create a transfer site, and test a transfer (page 12). 

These initial tests will introduce Pat to the FileXpress Gateway user interface and confirm 
that the installation and initial setup was successful. 

4 Add a new external user using email registration (page 16). 

This test will help Pat confirm that new customers will be able to log in to the FileXpress 
Transfer Client using email self-registration. 

5 Configure email notifications to be sent when files are uploaded or downloaded (page 17). 
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With this test, Pat will confirm that sales agents will receive emails to monitor their 
customers' file transfer activity. 

6 Configure a Post Transfer Action to copy uploaded files to a new location (page 18). 

Automatic Post Transfer Actions will move completed customer forms to the required server 
location for further processing. 

7 Use LDAP integration to provide internal users with access to the FileXpress system (page 
20). 

Setting up LDAP integration will enable internal administrators and traveling agents to 
access the FileXpress system using their corporate Windows domain credentials. 

8 Set up delegated administration to enable agents to add customers and set up transfer 
sites (page 21). 

To set this up, Pat will add agents to the Transfer Site Administrators group. For simplicity, 
the procedure provided in this guide adds an external user who has been added to the 
FileXpress database. In practice, Pat will add internal users from the integrated LDAP 
database. 

9 Enable transfer auditing (page 22). 

When audit logging is enabled, the FileXpress Secure Shell Proxy will create a new log 
each day with complete information about all transfer activity. 

 

Install the Evaluation Software 

For this evaluation, you'll install all three FileXpress Gateway services on a single system and 
transfer files to and from that system. (If you set up the optional Reflection for Secure IT 
Server, it must be installed on a separate system. It is not required for this evaluation.) 

Note: If you prefer to evaluate using a distributed system, you will need to run the installer on 
each computer in your configuration, selecting the appropriate features for each installation. 
For details, see Installing FileXpress Gateway 
(http://docs.attachmate.com/filexpress/gateway/1.0/admin-guide/fxg_install_pr.htm) in the 
FileXpress Gateway Administrator's Guide. If any of your test systems are outside your network 
firewall, also review the information under Ports and Firewall Configuration 
(http://docs.attachmate.com/filexpress/gateway/1.0/admin-guide/fxg_ports.htm). 

To install an evaluation copy of FileXpress Gateway 

1 Log in as an administrator on the Windows Server that you are using for your evaluation. 

2 Go to the FileXpress Gateway evaluation request page 
(https://www.attachmate.com/products/filexpress/filexpress-gateway-eval-form.html).Enter 
the requested user information, and click Submit. This sends an email message with 
download instructions to the address you provided. 

3 Open your Attachmate Product Evaluation email message and click the download link. This 
link takes you to a list of available downloads, including both FileXpress Gateway and the 
free PKI Services Manager Add-On.  

Note: For this evaluation you do not need to install PKI Services Manager. 

http://docs.attachmate.com/filexpress/gateway/1.0/admin-guide/fxg_install_pr.htm�
http://docs.attachmate.com/filexpress/gateway/1.0/admin-guide/fxg_ports.htm�
https://www.attachmate.com/products/filexpress/filexpress-gateway-eval-form.html�
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4 Download and launch the filexpress-gateway-1.0.0.nnn.exe file.  

5 Select a location for the installer files and click OK. The files are extracted to the specified 
location, and the Setup program starts.  

6 Install using defaults. This installs all three FileXpress Gateway services: the Secure Shell 
Proxy, the Transfer Server, and the Gateway Administrator. 

Note: FileXpress Gateway requires the Microsoft Visual C++ Redistributable Package. It is 
installed by the Setup program if it is not already on your system. The FileXpress Gateway 
installation continues after this prerequisite is installed. 

7 Select the option "Restart my computer for me."  

Note: A Windows restart is required to complete the installation. It also starts the 
FileXpress Gateway services. To confirm that the services are installed and running, you 
can use the Windows Services console (Start > All Programs > Administrative Tools > 
Services). The following three services should be present and running: Attachmate 
FileXpress Gateway Administrator, Attachmate FileXpress Secure Shell Proxy, and 
Attachmate FileXpress Transfer Server. 

 

 

Initial Setup 

Once you have installed the FileXpress software, you'll need to set up your system using the 
following one-time system setup steps. 

Try it now 

Enable FileXpress connections in the FileXpress Secure Shell Proxy 8 

Log on to the FileXpress Gateway Administrator 9 

Configure email support in FileXpress Gateway Administrator 10 

Install Java on client systems 12 

 

 

Enable FileXpress connections in the FileXpress 
Secure Shell Proxy 

To support file exchange using the FileXpress Gateway, you must configure the FileXpress 
Secure Shell Proxy to enable access by FileXpress users. FileXpress users can include both: 

 External users 

These users do not have domain credentials in your organization. FileXpress transfer site 
administrators can add external users to the FileXpress database by filling in complete 
information or by triggering email notification that enables users to set their own 
passwords. In a typical deployment these are customers or business partners. 
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 Internal users 

Users who have domain credentials within your organization. FileXpress administrators can 
configure LDAP integration with your Windows domain to enable these users to log in to 
FileXpress using their domain credentials.  

To configure the FileXpress Secure Shell Proxy 

1 Start the FileXpress Secure Shell Proxy console. It is installed in the Windows Start menu 
(or Apps list) under Attachmate FileXpress Gateway > FileXpress Secure Shell Proxy. 

2 On the FileXpress Users pane, enable Allow access to FileXpress users. 

Note: Gateway Administrator host is set to "localhost" by default. If you installed all 
FileXpress Gateway services on the same computer, you can leave the default value. If you 
decided to test on multiple systems, you need to edit this to specify the name of the host 
running Gateway Administrator. 

3 Click Activate and verify. This saves your settings and triggers actions that ensure that the 
FileXpress Proxy services can establish a secure connection with the Gateway 
Administrator.  

• You will be prompted to accept the certificate presented by the Gateway Administrator 
server. Click Yes to establish the trust relationship.  

• When the configuration update is complete, click Close to close the Web service 
connection dialog box.  

• Click Yes when prompted to restart the FileXpress Transfer Server service. This step is 
required. 

 

Log on to the FileXpress Gateway Administrator 

FileXpress Gateway Administrator is a web-based tool for provisioning users and configuring 
transfers. Use the next procedure to connect to Gateway Administrator and review the system 
setup options. Your initial logon resets the default administrative password. 

To connect to the FileXpress Gateway Administrator and log on 

1 To start the FileXpress Gateway Administrator from the Windows Start menu, go to 
Attachmate FileXpress Gateway > FileXpress Gateway Administrator. (The Start Menu 
option is available on the system you installed FileXpress on. You can also log on from 
other systems using your web browser. Enter a URL in this format: 
https://<gateway_administrator_host>:9490. ) 

Note: You will see a warning message in your browser before you see the login page. This 
warning shows up because the FileXpress Gateway Administrator installs with a self-signed 
security certificate that is unknown to your browser. For initial testing purposes, you can 
ignore this warning and proceed with the connection (Internet Explorer or Chrome) or add 
an exception (Firefox). Detailed information about replacing the self-signed certificate is 
available in the FileXpress Gateway Administrator's Guide. 
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2 For your initial logon, enter the following credentials:  

Username: admin 

Password: secret 

3 Immediately after your first logon, you will be prompted to change the password for the 
admin account.  

Because you will be using the default admin account in tests that demonstrate email 
notification, you should edit this account to specify an actual email address that you have 
access to. Here's how: 

To update the email address of the default admin account 

1 From Gateway Administrator, click the Users tab. 

2 Select the default "admin" user and click Edit. 

3 Edit Email address and click Save. 

 

Configure email support in FileXpress Gateway 
Administrator 

FileXpress supports a number of optional email notification services. These include: 

 Account creation email for new users 

 Password reset email 

 Transfer site access notifications 

 Notifications sent to site managers and/or site members when files are uploaded or 
downloaded 

To support these services, you need to set up the connection to your email server and configure 
the server address that will be used in URL links included in email messages. 

To configure the email server connection  

1 Log on to Gateway Administrator using the admin account and go to System > Email 
Server.  

2 Set Email service to Enabled and then enter required values for connecting to your server. 
Click the Help icon on the Email Server tab for information about these settings. Look for 

this in the upper right corner:  

3 If Check server identity is selected (the default), click Retrieve Cert. 

4 Click Test Connection.  

Note: This tests the current on-screen settings. These settings are not saved until you click 
Save. 
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5 Click Save. 

The connection test on the Email Server page confirms that the server can be reached, but 
does not confirm that outgoing messages will be successful. You can use the next procedure to 
test an outgoing email. This helps ensure that the email server settings you entered meet your 
email server's requirements. 

To test an outgoing message using your email server settings 

1 Click the Email Templates tab. The Account Creation template is displayed by default. 

2 Below the template text, click Preview to expand this portion of the page. 

3 Enter your email address in the To box. 

4 Click Send Test Email. You should receive a sample Account Creation email.  

Notes:  

 The test email includes sample values enclosed in [square brackets]. When an actual email 
is sent, tokens in the message are replaced with actual values. 

 If this test fails, click the Help icon and search on "email troubleshooting". 

 

Emails sent to FileXpress users include a URL that they can click on to initiate a password 
reset or connect to the FileXpress Transfer Client. By default, these links use "localhost" as the 
server name. To make these links work correctly, you need to change this default by editing the 
Gateway Administrator properties file, as described in the next procedure. 

To configure the base server URL used in email message links 

1 Log out of the Gateway Administrator 

2 On the system running FileXpress Gateway Administrator, open the Gateway Administrator 
container.properties in a text editor. The default location of this file is: 

C:\Program Files\Attachmate\FileXpress\Gateway\GatewayAdministrator\ 
conf\container.properties 

3 Locate the following lines: 

# Public facing base URL of Transfer Server (for example 
https://attachmate.com:9492) 

transfer.server.url=https://localhost:9492 

4 Replace localhost with the host address of your FileXpress Transfer Server. For example: 

transfer.server.url=https://evalserver.mycompany.com:9492 

5 Save the edited properties file.  

Note: Any change to the properties file requires a server restart. 
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6 To restart the FileXpress Gateway server, open the Windows Services console (Start > All 
Programs > Administrative Tools > Services), select the service called "Attachmate 
FileXpress Gateway Administrator" and click Restart. Wait a few minutes after the server 
has started before connecting to the Gateway Administrator.  

 

Install Java on client systems 

The FileXpress Transfer Client is a Java applet that runs in a web browser. To complete the 
evaluation procedures, you need to have Java installed and running on the computer you are 
using for the evaluation and on any other computers you want to use to test the Transfer Client. 
Use the next procedure to confirm that Java is installed on your computer. 

To check for and/or install Java 

1 Go to the Oracle Java website (http://www.java.com).  

2 Do either of the following: 

• Click Do I have Java? to verify Java and check for out-of-date versions. 

• Click Free Java Download to download and install Java. 

 

Initial Testing 

The procedures that follow show how to add a test user to the FileXpress database, configure a 
transfer site, and test a transfer using the Transfer Client. These initial tests will introduce you 
to the FileXpress Gateway user interface and confirm that the installation and initial setup was 
successful. 

Try it now 

Add a test user 12 

Create a transfer site 13 

Log on to the Transfer Client and test a transfer 14 

 

 

Add a test user 

The next procedure shows you how to add a user and manually configure a password. This 
option does not require the user to use email registration. 

To add a user without relying on email registration 

1 Log on to Gateway Administrator using the admin account. 

2 Go to the Users tab and click New. 

http://www.java.com/�
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3 Set UserID to "Joe" and set email address to "joe@test." (Email addresses must be unique. 
Because this first test doesn't require using email, you can use an arbitrary address for this 
user.) 

4 Select Specify password and enter an easy-to-remember password for this test user. 

5 Click Save. 

 

Create a transfer site 

In the next procedure you will create a transfer site called "Test Files" and add the test user Joe 
to it.  

To create a transfer site and add an existing user to the site 

1 If you are not still logged on, log on to Gateway Administrator using the admin account. 

2 From the Transfer Sites page click Add. This opens the New Transfer Site page. 

3 For Transfer site name, enter "Test Files" then click in Directory name to enter this same 
name automatically. 

The transfer site name is visible to the end user. The directory name specifies the actual 
physical directory that will be created on the file storage server. Unless you have a reason 
to specify an existing directory, it's easiest to keep these the same.  

4 Click to set Send email notification to No. (The test user Joe does not have a valid email 
address. You will have an opportunity to work with email notification later.) 

5 Click in the search box under Existing User and start to type "joe" to search for your test 
user. When you see the email "joe@test" appear, select it and click Add.  

Your transfer site now has two users—admin (the user who created the site) and Joe (the 
user you just added.  

Note: The results list shows first and last names (if present) and email of users who match 
your search. Although the userID is also included in the search, it isn't displayed in the 
results list. 

6 Click Save. This returns you to the transfer site list with the Test Files site added to the 
list. 
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Log on to the Transfer Client and test a transfer 

Use the next procedure to log on to the FileXpress Gateway Transfer Client and test a transfer. 

To log on to the Transfer Client 

1 To start the Transfer Client from the Windows Start menu, go to Attachmate FileXpress 
Gateway > FileXpress Transfer Client.  

Note: The Start Menu option is available on the system you installed FileXpress on. This 
automatically launches your browser and enters the correct URL You can also log on by 
entering this URL manually. In later procedures you'll see how to generate email that 
includes a link with the correct URL. 

2 As with Gateway Administrator, you will see a warning message. For initial testing 
purposes, you can ignore this warning and proceed with the connection (Internet Explorer 
or Chrome) or add an exception (Firefox). This should take you to the Transfer Client login 
page. 

Note: After you replace the self-signed certificate with one signed by a well-known 
Certificate Authority, users won't see this certificate warning.  

3 Log on as Joe using the password you entered when you created this user. 
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4 Because the Transfer Client is a Java applet, you'll see additional Java warning messages. 
Java uses security messages to ensure that only software you approve runs on your system. 
For each message, confirm that you want to continue. (The FileXpress Gateway 
Administrator's Guide includes additional information about these messages and how to 
turn off their display.) When you are successfully logged in, your display should look similar 
to the screenshot below. 

5 Browse the local files and drag-and-drop some sample files into the Demo folder. Also test 
a download to confirm that your test user can transfer files in both directions. 

Note: You can modify upload and download permissions for a transfer site at any time 

using the icons next to a user on the transfer site page. Green icons (  for uploads and 

 for downloads) indicate that transfers are enabled. Click these icons to disable transfers 

in either direction. Disabled transfers are indicated with gray icons (  and ). Transfers 
in both directions are enabled by default. 

6 Click Logout and close your browser when you are done. 

 

Note: If are doing your evaluation using a single system, the local files on the left and the 
server files on the right are actually on the same system. (You can find your uploaded files on 
this system in the default storage folder: 
C:\ProgramData\Attachmate\RSecureServer\FileXpress.) In a typical production 
deployment, the server files will be on your designated file storage server. 
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Working with Email Notification 

The next procedures show you how to enable new users to create their own passwords and how 
to configure email notification for file uploads and downloads.  

Before you begin 

 Confirm that you have done all the steps described under Configure Email Support in 
FileXpress Gateway Administrator (page 10). 

 Choose an email address to use for a new test user. You will need access to email at this 
address to see how email registration works. Because email addresses must be unique, this 
cannot be the same email address you used for the admin user.  

Try it now 

Try out email registration 16 

Receive upload and download notifications 17 

 

 

Try out email registration 

In the earlier exercise to add the test user "Joe", you provided the user password. It is also 
possible to configure FileXpress to send an email notification to new external users that enables 
these users to set their own passwords. In the sample evaluation scenario, this approach will be 
used by sales agents to provision new customers. 

To add a new user using email registration 

1 Log on to Gateway Administrator using the admin account. 

2 Go to Users and click New. 

• Set UserID to "Mary." 

• Set Email address to an actual email address that you have access to. 

• Click Save. 

3 Go to the email client for the address you used. You should see an email with the subject, 
"Your FileXpress User Account." 

4 Open the email. Note the following values, which are provided using FileXpress email 
tokens: 

• The username (Mary in this example) is provided in the first paragraph. 

• The link in the second paragraph uses the base URL you configured in the Gateway 
Administrator properties file. 
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• The email in the last paragraph is the email you set for the admin user who created 
this account. 

5 Click the link in the second paragraph and proceed past the certificate error. 

6 Enter the Username (Mary in this example) and click Reset. 

7 Return to the email address you used for this account, open the "FileXpress Password 
Request" email and click the link in this email. This takes you to the Change password 
page. 

8 Enter Mary for Username, enter a password for this user and click Submit. 

You should see a message saying "Login successful. You have no transfer sites available." 
(If you have already added the new user to one or more transfer sites, the Transfer Client 
opens and displays the available sites.) 

9 Return to the email address to find a confirmation message with the subject "FileXpress 
Account Update." 

You can customize the content and format of this message. The default is shown below: 

 

Note: If you want to repeat this test, delete the user first. Account creation email is sent only 
when a user is initially created. 

 

Receive upload and download notifications 

File transfer notifications are not enabled by default. Use the next procedure to see how these 
work. 

To receive email notifications when files are transferred 

1 Log on to Gateway Administrator using the admin account.  

2 On the Transfer Sites page, select the Test Files site you created earlier and click Edit. 

3 Scroll down to the user list. On the admin user row, under Notifications, click the upload 

notification icon to change it from gray  (disabled) to green  (enabled). Enable 

download notification  in the same way.  

4 Click Save. 
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To view the email notifications 

1 Log on to the Transfer Client using the test account for Joe and transfer files both to and 
from the Test Files site. 

2 Open the email account you set for the admin user. You should see messages with the 
subject "FileXpress Upload Success Notification" and "FileXpress Download Success 
Notification." 

  

Note: If you have followed through all the examples in this guide, the administrator's email will 
also include a delivery failure notification. When an account is added to a transfer site, 
FileXpress sends the added user a Transfer Site Access email. When you use a non-existent 
email address like joe@test, this attempt fails and the administrator receives notification of this 
failure from the email server. 

 

Configuring Post Transfer Actions 

You can use FileXpress Post Transfer Actions (PTAs) to automate processes after a file is 
successfully uploaded to the server. The next procedures demonstrate how to use this feature to 
copy an uploaded file to a specified location on your server. 

Setting up a PTA 

Elevate the privileges of the Gateway Administrator service 18 

Create a PTA to copy uploaded files to a new location 19 

 

 

Elevate the privileges of the Gateway Administrator 
service 

By default, the Gateway Administrator runs using the Network Service account, which has 
limited privileges. This helps ensure the security of your system by reducing the risk of an 
elevation of privilege attack; however it can also prevent Post Transfer Actions from running in 
some configurations. 

Note: The following procedure for elevating the privileges of the service is required in the 
default evaluation configuration used in this guide, where all three FileXpress Gateway services 
on the same system. This step is not required in a production environment where you've set up 
file storage on an SFTP server. 

To increase the privileges of the Gateway Administrator Service by 
running as the Local System account 

1 On the FileXpress Gateway Administrator computer, open the Windows Services console 
(Start > All Programs > Administrative Tools > Services). 

2 Right-click the Attachmate FileXpress Gateway Administrator service, select Properties, 
then select the Log On tab. 
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3 Set Log on as to Local System account and click OK. 

4 Click Restart to restart the service. Wait a few minutes after the restart before continuing 
your evaluation. 

 

Create a PTA to copy uploaded files to a new 
location 

Use the following procedures to create a new PTA, add it to the Test Files transfer site, and test 
a transfer that triggers this action. 

To define the PTA 

1 Log on to Gateway Administrator using the admin account. 

2 On the Actions tab, click New.  

3 Set the following values. This example uses the DOS cmd command to copy uploaded files 
to a folder called c:\fxgout. The PTA token $FULL_PATH$ resolves to the full path and 
filename of the uploaded file. The /c argument specifies that the cmd command should 
exit the command after the action is carried out.  

Action Name Copy File 

Program cmd 

Arguments /c copy "$FULL_PATH$" c:\fxgout 

4 Click Save. 

To add the PTA to your transfer site 

1 In Gateway Administrator, go to the Transfer Sites page. 

2 Select the Test Files site and click Edit.  

3 Click the Add actions drop-down list and select the Copy File action you just created. 

4 Click Save. 

To test your PTA 

1 Create a c:\fxgout folder on the computer running FileXpress Gateway. This is the 
destination folder for the file copy and it must exist for the PTA to run.  

2 Log on to the Transfer Client using the Joe account. 

3 Upload a file to the Test Files site.  
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4 Check the file system for the uploaded file and the copy: 

To find Look here 

uploaded file C:\ProgramData\Attachmate\RSecureServer\FileXpress\Test Files 

copied file c:\fxgout 

Note:  

 Output from PTA programs is sent to the Gateway Administrator console log. This log also 
contains additional information that is useful for troubleshooting PTAs. You can find the 
log files in the following location.  

C:\Program Files\Attachmate\FileXpress\Gateway\GatewayAdministrator\ 
logs 

The console log files are named using the current date in the format: 
consoleyyyymmdd.log. 

 

 

LDAP Integration 

You can use FileXpress Gateway's LDAP integration to add users who have accounts in Windows 
Active Directory. This enables network users to log on to the FileXpress Transfer Client using 
their domain credentials and transfer files. Each time an LDAP user logs in, current information 
is retrieved from the LDAP server. 

To add users from an LDAP server 

1 Log in using the admin account and go to System > LDAP Servers.  

2 Click New. 

3 Enter information for connecting to your LDAP server. For details see LDAP Server 
Configuration (http://docs.attachmate.com/filexpress/gateway/1.0/admin-
guide/new_ldap_server_cs.htm) in the Administrator's Guide. 

Note that the value for UserID must include the domain. For example: 

mydomain\user 

-or- 

user@mydomain 

4 Click Test Connection to confirm that Gateway Administrator can access your LDAP server. 
This test verifies the connection, but does not save your settings. 

5 Click Save. 

After you've added an LDAP server you can add users from that server to FileXpress transfer 
sites and groups. To view these users look for the LDAP server drop-down list on the 
configuration pages, and select your added server. 

 

http://docs.attachmate.com/filexpress/gateway/1.0/admin-guide/new_ldap_server_cs.htm�
http://docs.attachmate.com/filexpress/gateway/1.0/admin-guide/new_ldap_server_cs.htm�
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Delegated Administration 

The default admin account that has been used in this guide is a member of a built-in 
FileXpress group called Administrators. This group has complete privileges to modify all system 
settings as well as adding users and transfer sites. When you want to delegate more limited 
responsibilities to users, you can add them to groups with more limited privileges. As an 
example FileXpress Gateway provides a default group called Transfer Site Administrators.  

Members of the Transfer Site Administrators group can create and manage transfer sites and 
add users. Unlike members of the Administrator's group, these users can view only the sites 
that they have created (or sites someone else has given them rights to manage). To see how this 
works, you can add a test user to this group.  

For example, to meet the requirements described in the sample evaluation scenario, each sales 
agent will be added to the Transfer Site Administrators group.  

To add the user "Joe" to the Transfer Site Administrators group 

1 Log on to Gateway Administrator using the admin account. 

2 From the Users page, select the user "Joe" and click Edit.  

3 Use the FileXpress group membership drop-down list to add this user to the Transfer Site 
Administrators group. Notice that after you do this, you can see that Joe will inherit two 
new roles from this group: Manage transfer sites and Manage FileXpress users.  

4 Click Save. 

5 Click Logout to log out of the admin account, then log in to Gateway Administrator as Joe. 

Joe sees a different view of Gateway Administrator. Only three tabs are visible: Transfer 
Sites, Users, and About. The transfer sites you created using the admin account are not 
visible to this delegated user. 

6 Try creating and testing a transfer site, then log in again as admin to see that all the 
sites—including the one you created as a delegated administrator—can be seen and edited 
by a member of the Administrators group. 
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For more information about working with roles, see Roles in FileXpress Gateway 
(http://docs.attachmate.com/filexpress/gateway/1.0/admin-guide/fxg-roles-ov.htm) in the 
Administrator's Guide. 

 

File Transfer Auditing 

You can use FileXpress audit logging to maintain a complete record of all file transfer activity 
(including both failed and successful uploads and downloads). The audit file is a comma-
delimited text file with detailed information about each transfer. Audit logging is configured 
using the FileXpress Secure Shell Proxy. This is the same application you used when you 
enabled FileXpress connections (page 8).  

To enable file transfer auditing  

1 Start the FileXpress Secure Shell Proxy console (Attachmate FileXpress Gateway > 
FileXpress Secure Shell Proxy. 

2 Go to Configuration > Logging > Audit Logging. 

3 Select Enable file transfer auditing and save your settings (File > Save Settings). 

  

 

  

To view the audit log 

1 Log on to the FileXpress Transfer Client using any account for which you have configured a 
transfer site, and then transfer files in both directions. 

2 From the FileXpress Secure Shell Proxy console, use the audit log file toolbar button to 
view the audit log: 

 

 

 

http://docs.attachmate.com/filexpress/gateway/1.0/admin-guide/fxg-roles-ov.htm�
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Setting up an SFTP File Storage Server 

The evaluation exercises in this guide use a configuration in which all services and file storage 
are on the same system. In an actual production environment you will generally want to 
configure a file storage server located securely within your internal network as shown below. 
This can be any UNIX or Windows SFTP-enabled SSH server.  

 

The FileXpress Gateway installation package includes the Reflection for Secure IT Server for 
Windows, which you can install on your file storage server. Or you can use any existing SFTP 
server available in your network. You will need to know the name or IP address of the SFTP 
server, and obtain valid user credentials for logging on to this server. 

To configure file storage on an SFTP server 

1 Log on to Gateway Administrator using the admin account 

2 Go to System > File Storage and select SFTP server.  

3 Enter values for Server and Port. 

• Click Retrieve to retrieve the host key for this server. 

• For UserID and Password, enter valid credentials on this server. 

• For Base directory, click Browse and select a location available to this user. By default, 
the base directory is set to a subdirectory called FileXpressGateway in the directory 
you select. This is not required; you can edit or delete this subdirectory name. 

4 Click Save. 
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After you make this change, files are transferred to and from the SFTP server using directories 
created within the specified base directory. 

 

 

Certificate Authentication 

By default, users log on to the Transfer Client with a user name and password. You can also 
configure authentication using X.509 certificates, which may be on a Smart Card or configured 
on user systems. Support for this feature is provided in part using the Attachmate PKI Services 
Manager, a certificate validation service that is available at no extra charge with FileXpress 
Gateway. 

For information about how to install and configure PKI Services Manager and configure 
certificate authentication for FileXpress Gateway users, see Configure Certificate User 
Authentication (http://docs.attachmate.com/filexpress/gateway/1.0/admin-
guide/fxg_configure_cert_authentication.htm) in the Administrator's Guide. 

 

http://docs.attachmate.com/filexpress/gateway/1.0/admin-guide/fxg_configure_cert_authentication.htm�
http://docs.attachmate.com/filexpress/gateway/1.0/admin-guide/fxg_configure_cert_authentication.htm�
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